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SDLP CODE OF CONDUCT 

ALL SDLP STAFF ARE REQUIRED TO: 

 

❖ Confirm receipt of all assignments within 24 hours. 

 

❖ Fulfill all assignments to the best of their ability and within the scheduled time allotted for each step 

in the editing process. 

 

❖ Communicate and coordinate with the editing team in advance if any scheduling conflicts arise 

between SDLP assignments and other commitments. All assignment deadlines are strict. 

 

❖ Verify there is no plagiarized language in articles for publication during the editing process. If there 

is a question as to plagiarism, notify the Senior Editor and the EICs immediately. 

 

❖ Attend Mandatory Events which include: All staff meetings for Fall and Spring Semester, Article 

Team Meetings (each semester), and the SDLP Symposium. Communicate in advance if any 

scheduling conflicts arise. 

 

DEMERITS 
 

Two demerits may be cause for an individual’s name to not be published in the subsequent issue of SDLP or 

loss of opportunity for an elevated title. Three demerits may be cause for an individual to be terminated from 

SDLP. Demerits are up to the final discretion of the Executive Editor and Editor-in-Chiefs. 

 

Demerits are granted only in occasions where a person objectively fails in their responsibilities or harms SDLP. 

This is a contextual analysis left to the discretion of the Executive Editor and Editor-in-Chief.  

 

A few per se reasons will result in a demerit, including: 

 

❖ Missing a deadline without communicating ahead of time with the Senior Editor, Executive 

Editor, or Editor-in-Chief. 

 

❖ Failure to fulfill an assignment that has been returned for corrections within 48-hours. 

 

❖ If your assignment is returned TWICE in the same school year. 

 

❖ Missing a mandatory meeting or event without communicating with the Managing Editor. 

 

ADDITIONAL ACTIONS 

 

In addition to the above demerit system, SDLP reserves the right to take further actions when a staffer fails to 

complete an assignment.  

 

This includes students who have an assignment and drop out of SDLP without notifying the Editorial Board at 

least 72 hours before the deadline. 
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SDLP CONTACT INFORMATION 
 

The SDLP office is located on the Basement Level of the Capital Building in Room CT03.  

You may contact any board member through the SDLP email, sdlp.wcl@gmail.com.  

 

You may also refer to our website at:  

https://www.wcl.american.edu/org/sustainabledevelopment/ 

 

 

SDLP EDITING PROCESS 
 

SDLP utilizes a process called spading to prepare articles for publication.  Spading is a multi-step process to 

verify the content of articles chosen for publication; edit the piece for grammar, spelling, and proper sentence 

structure; and properly format an article’s footnotes according to Bluebook citation rules.   

 

To complete the spading process, you will need the 20th Edition of the Bluebook as well as the SDLP Staff 

Manual.  Use the manual as a reference throughout the spading process.  SDLP divides the spading process into 

seven rounds of editing.   

 

You will be given an access code to Adobe Acrobat Pro in the beginning of the semester to help you with the 

spading process. 
 

The spading process for a Staffer is divided into two main parts: Source Collecting and Editing.  

 

Source collecting is the process of finding each source that the author uses to support his or her assertions and 

verifying that what the source does in fact support what the author says in his or her article.  When you find a 

source, you must highlight the relevant portions that support the author’s assertion, collect the other required 

portions of the source (see instructions below) and then upload it to your Dropbox folder.  

 

Editing the article means that you edit above the line (the content) for grammar, spelling, sentence structure, 

and readability and then edit below the line (footnotes) for proper Bluebook format.  

 

Before you begin any edits, make sure that TRACK CHANGES IS ON. After you have completed source 

collecting and editing, your Senior Editor will check your work.  Then the Senior Editor will redistribute the 

assignments to the Staffers and you will check another Staffers’ assignment.  

 

The more eyes that are checking the work, the less mistakes we have! If you have any questions at all about this 

process, ask your Senior Editor or Executive Editors ASAP!  We are here to help!  Reach out to us, and we will 

meet with you if you need help bluebooking!  

 

  

mailto:sdlp.wcl@gmail.com
mailto:sdlp.wcl@gmail.com
https://www.wcl.american.edu/org/sustainabledevelopment/
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There are seven rounds to the SDLP Editing Process:  

 

 ROUND 1- INITIAL EDIT (EIC, Executive Editor, Associate Executive Editor) 

 ROUND 2- FIRST SENIOR EDIT 

 ROUND 3- FIRST STAFFER SOURCE COLLECTING AND EDITS 

 ROUND 4- SECOND SENIOR EDIT 

 ROUND 5- SECOND STAFFER EDIT 

 ROUND 6- THIRD SENIOR EDIT 

 ROUND 7- EIC AND EXECUTIVE EDITOR FINAL EDIT 
 

Spaders are part of Rounds 3 and 5 of the editing process.  
 

The timeline for the spading process is set by your Senior Editor, but generally follows this time frame: 
 

• Round 3 | Week 1-2: Staffer does Source Collecting and Editing 
 

• Round 4 | Week 2-3: Senior Editor checks Staffer’s work  
 

• Round 5 | Week 3-4: Staffer checks another Staffer’s work 
 

Please pay close attention to these instructions as SDLP as its own requirements for spading that may be 

different from another legal publication you have worked on. 

 

 

ROUND 1- INITIAL EDIT (EIC, Executive Editor, Associate Executive Editor) 
 

❖ Select articles for publication. 

❖ Initial textual editing for grammar, flow, and strength of argument (use tracked changes for all 

edits to article). 

❖ Note deficiencies to be fixed during editing and insert blank footnotes where more support is 

required. 

❖ Communicate with authors if additional work is needed or citation is significantly lacking. 

❖ Develop a plan to edit the article. 

❖ Instruct Editing Team of Due Date and give reminders as necessary. 

❖ Create a Dropbox folder for each article containing the article itself.  

❖ Upload Spading/Editing Checklists to the Dropbox.  

 

ROUND 2- FIRST SENIOR EDIT 
 

❖ READ entire article. 

❖ Make textual edits as you go adding to the EICs initial work (use track changes for all edits to 

article). 

❖ Insert blank footnotes if needed, make a note by any footnotes that need better sources. Make 

sure you give a brief explanation of why a footnote is needed in a comment bubble. 

❖ Draft Team Memo, which should contain deadlines, specific problems to be looked at, and 

division of footnotes.  The memo should be emailed to each team member and uploaded to the 

Dropbox folder. 

❖ Create individual Dropbox subfolders for each Staffer. Make sure you properly share the folder 
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with each team member. 

❖ Hold an in-person Team Meeting before you distribute the assignment to the team. At this 

meeting, you shall go over the assignment, any particular problem areas of the assignment, 

assign the range of footnotes for each staffer, clarify deadlines, and answer any questions about 

the assignment. 

 

ROUND 3- FIRST STAFFER SOURCE COLLECTING AND EDITS 

❖ READ entire article 

❖ SOURCE COLLECTING 

➢ For each footnote in your assigned range: 

• Find the source.   

o Google is always a great place to start. You may need to search Westlaw, 

Lexis, HeinOnline (available for free through the WCL Pence Law Library 

Website), Leagle, JSTOR, the Library, the American University Library, or 

even go to the Library of Congress to obtain the source.  If you need to submit 

an Inter Library Loan you MUST notify your Senior Editor.  If you need help 

searching, ask your Senior Editor, Executive Editor, Editor-in-Chief, or a 

librarian. 
 

• The Library research guides on environmental, international, statutory, 

and public laws may prove useful.  These research guides are available 

on the Pence Law Library website at:  

http://library.wcl.american.edu/resources/trg_legalresearch.cfm 

 

➢ HIGHLIGHT the relevant portion of the source that supports the author’s assertion(s). THIS 

IS CRUCIAL AND MUST BE DONE. This is so the Senior Editors and Executive Editors 

know exactly where the information used by the author came from.  

 

➢ Collect ALL relevant information: 

 Most sources will be found online whether they are once-hard copy 

sources now available online, webpages, online newspaper articles, 

cases, etc. For online sources, you must also collect the pages that 

show: 

o the title of the source, 

o the author of the source, 

o the date of the source 

o the pincite (the page that contains the supporting information) 

o the page before the pincite page and the page after the pincite page 
 

✓ For example, the author cites to an online article by Bill Nye 

on National Geographic’s website.  

▪ The title of the article, the author, and the date appear 

on page 1.  

▪ The supporting information appears on page 5 of the 

10-page article.  

▪ I highlight the supporting information and collect page 

1, page 4 (the page before the pincite page), page 5 (the 

pincite page), and page 6 (the page after the pincite 

page).  

http://library.wcl.american.edu/resources/trg_legalresearch.cfm
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➢ You MUST then then convert the document (if it is not already in a PDF form) 

to a PDF and upload it to my assigned Dropbox folder. 
 

➢ Please delete the additional pages in your PDF viewer where the information 

is outside the scope of the author’s footnote.  

(You will be given an access code to Adobe Acrobat Pro in the beginning of 

the semester which will allow you to easily edit/modify these documents). 
 

 Upload a PDF version (either print to PDF or scan in if using book or 

other source only in hard copy) to your personal Dropbox folder.  

Document title should be:  

 FN #_Source author last name Source article title.   

 

 You may abbreviate the article title as appropriate.   

 

▪ Example:  FN15_Nye_ClimateChange. 

 

 For string citations (multiple sources within one footnote), be sure to label them as: FN 

#a, b, c Source author last name Source article title.  

 

▪ Example: FN 24a_Nye_ClimChange.   

     FN  24b_Nye_ClimChange. 

 

 For hard copy books that require scanning, scan: 

1. Title page 

2. Front matter (including publisher name, date, location, etc.) 
3. Table of contents for the entire book 
4. Relevant pages (based on pincite or the above the line assertions) 

❖ EDITING 
 

➢ #1 RULE OF EDITING: TRACK CHANGES MUST BE ON.  

 

o Never make any changes to an article without Track Changes on.  

o Never Accept or Reject changes to an article. 

 

➢ Content Above the Line 

 

o Make spelling, grammar, and sentence structure changes.  

o Please do not make changes that significantly alter the author’s voice.  

o Just because you would write something differently does not mean it is 

incorrect.  

o If you have a suggestion for how something can be written better, 

insert a comment bubble and explain why you think that sentence(s) 

should be changed. 

o Refer to your Bluebook and SDLP Staff Manual throughout editing. 
o Make sure that quotes are exactly as they appear in the cited source.  

o Ensure that there are two spaces between the period  

and the beginning of the next sentences. 
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➢ Content Below the Line- Footnotes 

 

o DO NOT edit a citation without having both the source in front of you 

and your Bluebook 

o Make sure that each source has a pincite (as needed) and that the 

pincite (or pincite range) is correct. 
 

o Common Citation Issues to Look for: 

✓ Supra and Infra: make sure that cross references are referring 

to the correct footnote as these may change throughout the 

editing process as footnotes are added/removed. 

✓ Signals & Parentheticals: Parentheticals are recommended 

after the “see,” “see, e.g.,” “c.f.,” “compare,” and “see 

generally.” If a parenthetical is needed, YOU must write 

one. Please do not write “(parenthetical needed).” Instead, 

suggest a parenthetical that begins with an -ing word ex) 

See Smith, supra note 5 (explaining dogs are superior to 

cats).  

✓ Rule 10.9(a) | Rule of Five: Use a short cite for Primary 

sources that appear within five footnotes of the current 

one. If the Primary source has not been cited within the 

last five  

✓ Italicization: Be careful to make sure that signals and their 

punctuation are italicized properly. For example, the period 

after “Id.” should be italicized. 

✓ Internet Sources: make sure the URL is correct and that it is still 

live. For internet cites that require “last visited” make sure you 

use the most recent date that you accessed the website. 
 

ROUND 4- SECOND SENIOR EDIT 

 

❖ Make sure the First Staffer did his/her job with complete source collection, editing the content, and 

using proper Bluebook format.   

❖ Verify that all footnote sources have been collected and properly highlighted, paying special 

attention that footnotes with multiple sources do in fact have all sources collected and that scanned 

sources have all the proper pages scanned per the First Staffer Edit note above. Edit footnotes if 

needed. 

❖ Bounce back any issues with the First Staffer’s work to the relevant editor. 
 

ROUND 5- SECOND STAFFER EDIT 
 

❖ For EACH Footnote: 

o Verify that the source cited stands for the assertion the Author has 

made, and that all pincites are correct. 

o Highlight relevant text based on the Author’s assertion in the source 

using Adobe’s highlighting tool.   

• Note: all quotes must be highlighted in the source. 

o Verify that all citations are in proper bluebook format, making any edits 



   
 

 

9 

with tracked changes on. 

o Make any obvious corrections you find above the line. 

o There will be footnotes that do not have sources, particularly those 

footnotes added by the EIC, the EE, or senior editor.   

o Fill in sources by using sources you have used in other footnotes or from 

other outside sources that support the author’s assertion, or look for 

additional sources if necessary.   

o If you are having trouble finding a relevant source, you MUST notify your 

Senior Editor. 

o        All citations should include pincites to the particular page(s) that are relevant. 
 

❖ Insert comments where there are issues with the sources and immediately inform 

the Senior Editor as to any problems as they arise so they can be quickly addressed.  

 EXAMPLE:  Source provided does not support the author’s 

assertion.  

 

❖ Pass the article and all associated materials to the Senior Editor through Dropbox.   
 

o It is important that you upload the newest version of all documents as you go, 

and do not wait until your deadline and upload everything at once.   

o Staffers should make an effort to conform all work to what other Staffers are 

doing.   

o Where there is a difficult or unusual citation in different places in the article, 

try to make sure you are all doing it the same  
 

ROUND 6- THIRD SENIOR EDIT 
 

❖ Make sure the Second Staffer did his or her job by spot-checking sources and 

Bluebooking—if not, bounce it back to the Staffers with comments as to what needs 

to be fixed.Tie up loose ends from the Second Staffer’s comments. 

❖ Make sure the Second Staffer did his or her job by spot-checking citation accuracy—if not, bounce 

back the article to the relevant Staffer 
❖ Make changes so that article format follows the Manual’s formatting guidelines (“SDLP Style 

Rules”—pg. 9). 

❖ Check each citation carefully for Bluebooking accuracy. 

❖ Go through the entire article again to make sure that all issues have been addressed and there are no 

additional changes needed.   

❖ When you pass it back up to the Executive Editors, they should be able to send it to the printer 

immediately (they will do a final edit, but you should not rely on them to correct mistakes).  

 

ROUND 7- EIC AND EXECUTIVE EDITOR FINAL EDIT 

 

❖ Read and edit entire article, including text, citation accuracy, Bluebooking, and overall quality. 

❖ Deal with ALL loose ends before seeking author approval. 

❖ Convert footnotes to endnotes. 

❖ Send to printer for layout and review the proof with the publisher. 
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SDLP STYLE RULES 
 

SDLP follows formatting and grammar rules that you may not use in your own writing. Please adhere to these 

rules to ensure consistency throughout SDLP articles (NOTE: Features editor may request that you adhere to 

other standards). 

 

❖ Article must be in Microsoft Word (*.doc) format, Times New Roman, single-spaced, 

12-point font when in final format. 

❖ Article must have an Introduction and Conclusion. 

❖ Do not use roman numerals except for longer articles or where the author cross-

references sections in the introduction or in footnotes. 

❖ If you use sub-headings, there should be at least two sub-headings under each major 

heading (and the same is true for sub-sub-headings). 

❖ Use endnotes, not footnotes, and they must be numbers, not roman numerals. The EIC will 

convert the footnotes to endnotes after the editing process is complete. 

 

o To convert: Insert => Reference => Footnote => Convert. (MS Word 2003) 

❖ Use two spaces between period and new sentence. 

❖ Use two spaces after a colon 

❖ Do not indent paragraphs. 

❖ Lists of three or more should have comma before the “and” or “or.” (Rule 1.16). 

 

 Example: Beer, liquor, and cigarettes. 

❖ Abbreviations should NOT have periods. 

 

 Example: EU, not E.U. The single EXCEPTION is for U.S. 

(never use US). 

Italicize—not underline—court case names. 

❖ Quotation marks must be put around abbreviations in parentheses when first introduced. 

 

 Example: The Environmental Protection Agency (“EPA”) is . . . 

 

o Use double quotation marks. Single quotation marks are only used for a quote-within-a-

quote. 
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❖ Capitalization: Always capitalize “Agency”, etc. when it is part of the body’s name, but 

do not capitalize when it is not 

o The Commission’s decision is final. (Referring to the Federal Trade Commission) 

o The administration’s process is not finished. (Referring to the Environmental 

Protection Agency) 

 

❖ Ellipsis: Use typed out ellipsis, not auto-correct ellipsis; they DO look different. There 

should be a space between the last work and the first period and each subsequent period. 

 

 Good Example: “EPA has jurisdiction over . . . state 

implementation plans.” 

 Bad Example: “EPA has jurisdiction over … state 

implementation plans.” 

❖ Decades should not have apostrophes. 

 

 Example: 1990s, NOT 1990’s. 

❖ Dollars and Euros should be written out when the number is written out. The dollar sign 

($) or euro symbol (€) should be used when numerals are used. When denoting U.S. 

dollars, use “US$” and put a space between the dollar sign and the numeral. Instead of 

expressing large numbers in numerals or spelling them out in full, it is appropriate to use 

the following: $3 million. 

 

 Examples: Twenty dollars, $162, or US$ 54 million. 

 

❖ Numbers: Rule 6.2 

o Spell out numbers zero to ninety-nine in text and in footnotes use numerals for 99+ 

Exceptions: 

✓ Any number that begins a sentence should be spelled out. 

✓ Hundred, thousand, and similar round numbers may be spelled out if done so 

consistently 

✓ When a series includes numbers both less than 100 and greater than or equal 

to 100, numerals should be used for the entire series. 

✓ Numerals should be used if number includes decimal points. 

✓ Where the material repeatedly refers to percentages or dollar amounts, 

numerals should be used for those percentages or amounts. 

✓ Use % with numerals or “percent” with numbers written out. 
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USING Id., Supra, & Hereinafter 

 

❖ “Supra” is used when a source has already been cited in an endnote, but not in the endnote 

immediately preceding the current endnote. (Rule 3.5). It is different from “supra” for short citations 

(Rule 4.2). In this context “supra” serves the same function as “infra” and is used to refer to 

footnotes, sources, or text that comes before the citation 

●● “Accompanying text” means article text, not footnote text 

 

❖ Sources that cannot be short-cited with “supra” under Rule 4.2 (e.g., cases, statutes, regulations) CAN 

be referred to more generally using “supra” as an internal cross reference 

●● See supra note 12 and accompanying text. This is an internal cross reference to all sources 

and footnote text in footnote 12 and the material in the article text that footnote 12 is appended 

to 

 

●● See Sunstein, supra note 12, at 62. This is a short citation to page 62 of the Cass Sunstein 

article first cited at note 12. 

 

●● Supra must always be accompanied by the author’s name. If there is no author listed, use 

the title of the source. This is for our editing purposes, so that we can identify sources more 

easily. 

 

❖ “Id.” is used to cite to a source cited to in the previous endnote (when that source is the only source 

cited in the endnote). 

 

●● Available for ALL types of sources 

 

●● Always italicize the period 

 

●● Always double check the source to ensure that references to different page numbers or 

sections are indicated 

 

❖ Always accompany id. with the author’s name or title for SDLP editing purposes“Hereinafter” is used 

with “supra” when confusion might otherwise result. (See Bluebook Rule 4.2.) 

 

●● Available only for sources listed in 4.2 (same as supra) 

 

●● The text style of the short reference must match that of the full citation (e.g., small caps, 

italics, normal font) 
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GRAMMAR AND SPELLING 

 

There is a copy of the Redbook: A Manual on Legal Style (the Bluebook’s sexier cousin), Chicago Manual 

of Style, and Black’s Law Dictionary in the SDLP office. You are welcome and encouraged to use them all. 

 

When checking grammar and spelling, pay close attention to the following common mistakes: 

 

❖ Avoid use of passive voice. 

 

 Good Example: “The City Council charged the park and recreation board 

with maintaining the public parks.” 

 Bad Example: “The park and recreation board was charged with maintaining 

the public parks by the City Council.” 

 

❖ Verb tense should be consistent throughout the article—either past tense or present tense. 

❖ Verbs within a sentence should have “parallel construction.”  

❖ Do not mix nouns and verbs. 

 

 Good Example: Acting in dramas, playing tennis, and collecting stamps are 

my favorite hobbies. 

 Bad Example: Drama, playing tennis, and collection of stamps are my 

favorite hobbies. 

 

❖ Non-English words and phrases should be italicized. Some Latin phrases common in legal writing are 

not italicized. To verify whether a Latin word or phrase should be italicized, it is best to look it up in 

Black’s Law Dictionary and follow whether it italicizes the entry. 

❖ Use American English, not British English, spellings except for proper nouns (e.g., U.N. Environment 

Programme.) 

❖ Where possible, be gender neutral—avoid “his” and “her” unless referring to a specific person. 

❖ Punctuation comes before footnote number and inside quotation marks. 

 

 Example: I would Like a pickle.34 

 He smiled “knowingly.” 

 Example: The results of the experiment showed that “dogs are humans.”39 

 

❖ That vs. Which: “That” is used to restrict a category of things, while “which” is used to provide further 

information about a whole category of things. “Which” is always set off by commas. 

 

 Example: SDLP publishes many articles that are widely read. 

Meaning: SDLP publishes many articles, but only some are widely read. 

 

 Example: SDLP publishes many articles, which are widely read. 

Meaning: SDLP publishes many articles, all of which are widely read. 

 

❖ U.S. vs. United States: U.S. is an adjective. United States is a noun.  

o On the other hand, “UN” and “EU” can be used as either nouns or adjectives.  

 See Bluebook Rule 6.1(b); see also SDLP Style Rules. 
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 Example: The U.S. government proposed the project in May. 

 

 Example: The United States has proposed many projects. 

 

INTERNET BLUEBOOKING 
See RULES 16.6(f) & 18 

 

❖ The most common SDLP Internet citation forms are: 

 

1. Electronic version also available in print form. See Bluebook Rule 18.2.3. 

2. Online-only sources. See Bluebook Rule 18.2.2. 

3. Online newspaper sources. See Bluebook Rule 16.6(f). 

4. Online source in PDF format. See Bluebook Rule 18.2.2(f). 

 

❖ For basic citation form see Bluebook Rule 18.1(a). 

 

❖ Source available in original print format:  

• Normal citation + “available at” + web address in regular font, not formatted as a 

hyperlink: 

 

 Example: William H. Macey, Convergence in International Competition 

Policy, 97 AM. SOC’Y INT’L L. PROC. 309, 311 (2013), available at 

                                                   http://www.ftc.gov/speeches/other/031210kovacic.pdf. 

 

❖ Source available only via Internet or via an obscure or difficult to access print version: 

• Normal citation, no “available at” (for articles, use the website as the publication 

name) 

 

 Example: Mark Dantonio, Stanford Choked to MSU, 

BLOOMBERG.COM (Apr. 16, 2013), 

http://www.bloomberg.com/apps/news?pid=20670001&sid=aVCxRFr

q1FPU#. 

 

❖ Pincites: For direct internet citations, cite to specific page numbers if the document is in PDF 

form. 

❖ Website addresses should NOT be underlined or in blue/hyperlinked. Please make sure to 

remove the hyperlink instead of just changing the font color. 

 

 PCs: Right click, and then “Remove Hyperlink” 

 Macs: First highlight the link, then press Apple+K, a new window will open 

and then click “Remove Link” 

http://www.ftc.gov/speeches/other/031210kovacic.pdf
http://www.bloomberg.com/apps/news?pid=20670001&amp;sid=aVCxRFrq1FPU
http://www.bloomberg.com/apps/news?pid=20670001&amp;sid=aVCxRFrq1FPU
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❖ Direct Citation to Internet Sources now (v.19) requires that the website be in SMALL CAPS. 

For instructions on how to convert text to small caps, see Computer Tips at the end of this 

Manual. 

 Example: BEN & JERRY’S HOMEMADE ICE CREAM, 

http://www.benjerry.com (last visited Oct. 6, 2008). 

❖ Complex or long website addresses should be shortened with relevant instructions included. See 

Bluebook Rule 18.2.2(d). 

❖ How to list a date. See Bluebook Rule 18.2.2(c). 

 

❖ Where there is a direct citation to internet materials with the date, include a date parenthetical 

BEFORE the website address. 

 

 Example: Ashby Jones, Activists, Research Facilities Taking Disclosure 

Battles to Court, WALL ST. J. L. BLOG (Feb. 26, 2009, 9:40 AM), 

http://blogs.wsj.com/law/2009/02/26/activists-research-facilities-taking-

disclosure-battles- to-the-courts. 

 

❖ Where there is a direct citation to internet materials that does not have a date specifically 

associated with the material, but does have a date on the website, include a (last updated Oct. 3, 

2009) AFTER the website address. 

 

 Example: Dale Fast, History of Biology and Medicine, ST. XAVIER 

UNIV., http://faculty.sxu.edu/~fast/general_biology/history.htm (last 

updated Oct. 31, 2001). 

 

❖ Where there is a direct citation to internet materials with no visible date on the website, 

include a (last visited Oct. 3, 2009) AFTER the website address. 

 

 Example: Stanley Kubrick—Biography, YAHOO! MOVIES, 

http://movies.yahoo.com/shop?d=hc&id=1800011072&cf=biog&intl=us  

(last visited Nov. 24, 2009). 

 

 

http://www.benjerry.com/
http://blogs.wsj.com/law/2009/02/26/activists-research-facilities-taking-disclosure-battles-
http://blogs.wsj.com/law/2009/02/26/activists-research-facilities-taking-disclosure-battles-
http://faculty.sxu.edu/~fast/general_biology/history.htm
http://movies.yahoo.com/shop?d=hc&amp;id=1800011072&amp;cf=biog&amp;intl=us
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❖ When a source is available or probably available in a traditional printed medium, a parallel 

citation to an Internet source with identical content should be provided if possible. The citation 

to the primary source should be formatted according to the applicable Bluebook rules and the 

parallel Internet citation should be introduced with the explanatory phrase “available at.” 

 

 Example: Debora MacKenzie, Disease runs riot as species disappear, NEW 

SCIENTIST, July 1, 2009, available at 

http://www.news.practicechange.net/?p=564#more-564 (discussing a report 

that shows an inverse relationship between biodiversity and disease rates). 

 

 Examples of when not to use parallel citation: 

 

▪ If you are citing to a treaty do not use the internet citation. Follow 

Bluebook Rule 21.4. 

▪ If you are citing to the “About NDI” page of the National Democratic 

Institute, this page will only be available on this website. Simply cite 

the website address in small caps and do not use “available at.” 

❖ When copy-and-pasting a hyperlink from the address bar of a web browser to Microsoft Word, 

be aware that spaces in the hyperlink automatically translate into “%” and creates a nonworking 

link.  

o If you see the “%” sign in your Word document, go back to the original link in your 

browser to verify whether it belongs in the webpage address, and if it does not, replace 

the “%” with a space in your document. 

 

❖ NOTE: Make sure to check URLs by plugging them in during spading to see if they still work. 

 

USE OF PARENTHETICALS & SIGNALS IN SDLP 

 

❖ Parentheticals include but are not limited to explanations of the contents of a source.  

o (See Bluebook Rules 1.2, 1.3, 1.4, 10.6, 18.2.3(c))  

o Explanatory parentheticals begin with an “-ing” verb such as “commenting.”  

o They may be useful if: (1) the reason for citing this source is not clear, (2) the source presents an 

argument on one side of a debate. 

 

❖ It is not necessary to include explanatory parentheticals after citations unless you feel that they will add 

useful information or clarification. 

 

 Example: Eileen Alt Powell, Citigroup Adopts Environmental Policy, 

Associated Press, Jan. 22, 2003 (commenting on Citi’s announcement of 

its intent to become the first American bank to adopt an environmental 

policy). 

 

❖ Explanatory parentheticals should be placed after “available at.” (See Bluebook Rule 18.2.3(c)) 

 

 Example: William Snape, Joining the Convention on Biological Diversity: 

A Legal and Scientific Overview of Why the United States Must Wake Up, 

SUSTAINABLE DEV. L. & POL’Y, Spring 2010, at 6, 6-8, available at   

http://www.news.practicechange.net/?p=564&amp;more-564
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http://www.wcl.american.edu/org/sustainabledevelopment/documents/SD

LP_10Spring.pdf (discussing the importance of the United States in 

protecting biological diversity). 

 

❖ Format-related parentheticals: such as “on file with author,” “emphasis added,” or 

“internal quotation marks omitted” and related authority parentheticals, such as “citing” 

or “quoting,” should be placed before the “available at” in the citation, if there is one. 

(See Bluebook Rule 18.2.3(c)) 

 

 Example: Debora MacKenzie, Disease runs riot as species disappear, 

NEW SCIENTIST, July 1, 2009, (emphasis added), available at 

http://www.news.practicechange.net/?p=564#more-564 (discussing a 

report that shows an inverse relationship between biodiversity and disease 

rates). 

 

❖ Order of parentheticals within a citation can be found at Bluebook Rule 1.5(b). 

 

❖ Signals are used at the beginning of a citation to indicate how the cited source relates to the 

text’s assertion. (See Bluebook Rules 1.2, 1.3, 1.4)  

o Three general signals are discussed below and more introductory signals can be 

found in Bluebook Rule 1.2: 

o [No signal] is used if the citation quotes the information in the article. An example 

of this would be a citation for a statistic. 

 

 Example: Dana Milbank, Bush Picks a Loyalist to Replace a 

Politician, WASH. POST, Nov. 11, 2004, at A1. 

 

o “See” is used if the information from the cited source is not directly stated in the article, but an 

inference can be clearly drawn that: (1) it has been taken from this source, and (2) it is used in 

the same context. 

 

 Example: See Dana Milbank, Bush Picks a Loyalist to Replace a 

Politician, WASH. POST, Nov. 11, 2004, at A1. 

 

❖ “See also” is used to provide additional sources that might be relevant, but the 

information has not been directly taken from these sources. This might be used if you 

cite several sources in the same endnote. An explanatory parenthetical is encouraged 

when using this introductory signal. 

 

 Example: [Citations to sources directly stating the point advanced in the text.] See 

also Dana Milbank, Bush Picks a Loyalist to Replace a Politician, WASH. POST, 

Nov. 11, 2004, at A1. 

 

❖ Separation (Rule 1.3): 

●● Semicolon: (a) sources using the same signal, and (b) citation sentences using the same 

signal type 

●● Period: Citation sentences using different signal types 

http://www.wcl.american.edu/org/sustainabledevelopment/documents/SDLP_10Spring.pdf
http://www.wcl.american.edu/org/sustainabledevelopment/documents/SDLP_10Spring.pdf
http://www.news.practicechange.net/?p=564&amp;more-564
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CHECKLIST FOR ALL EDITORS 
 

❖ Save sources as: FN #_Source Author Last Name_Source Article Title. 

 

 Example: FN 2_Jones_We Love SDLP.pdf 

 

❖ “Track Changes” is ALWAYS on. NEVER accept/reject any changes. 

 

❖ Skim the entire article first to get a sense of the author’s arguments. 

 

❖ Check that the article follows all Style Rules  

 

❖ Check that Grammar & Spelling is correct (p.11)  

 

❖ Check that ALL citations are correct (p. 15). 

 

❖ Address, delete, or redirect ALL comments. 

 

❖ Complete ALL special instructions from the Senior Editor and EICs.

 

NOTE ON COMMENTS: 

 

❖ If you insert a COMMENT into the article it MUST be directed to someone.  

 

❖ If there is a comment for you, you must either: 

 

1. Address the comments and delete it. 

2. Redirect the comment to the next person. 

 

❖ You may not simply state: “I couldn’t find the source.”  

o Provide details and include the next person who is responsible 

 

 Example: SENIOR EDITOR: I was unable to locate this source after checking 

Westlaw and seeking help in the library, please ask the author to provide a copy of 

the source. 
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CHECKLIST FOR STAFFERS 

 

 ✓ ALL Sources Collected. 

 

✓ Electronic files labeled and organized. 

  

✓ ALL citations converted to Bluebook format (use your Bluebook and ASK FOR   

     HELP). 

  

✓ Each source is ACCURATE. 

 

✓ The cited source says what the author says it does. 

  

✓ Each source is as AUTHORITATIVE as possible. 

  

✓ PARENTHETICALS have been added where necessary or useful; 

make sure all the author’s parentheticals are responsive. 

  

✓ SIGNALS have been added where necessary or useful and the ORDER 

of  signals conforms to Bluebook rule 1.4. 

  

✓ Additional instructions from Senior Editor and EICs are followed. 
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SDLP BLUEBOOKING CHECKLIST 
 

SDLP follows standard Bluebook format for citations. Use the following checklist and formatting examples 

to avoid common mistakes. 

 

Note: The point of a citation is not only to support the text, but also to make it easy for a reader to find the 

citation. This means they must be uniform and complete. 

 

❖ Determine the Format of the source and which Bluebook rule applies. **If you have problems figuring it 

out, talk to your Senior Editor. 

 

❖ RE-READ THE RULE before formatting the citation to verify its requirements. 

 

❖ Format the citation watching out for commas, periods, fonts, spaces, etc. 

 

❖ Format ABBREVIATIONS and CITATIONS correctly. 

 

 Case names T.6 

 Geography T.10 

 Months T.12 

 Periodicals T.13 

 Cases R.10 

 Statutes R.12 

 Internet R.18 

 International Materials R.21 

 

❖ Use Table T.13 for abbreviations to each word in journals not listed in the table. 

 

❖ Find every PINCITE (pinpoint citation) and ensure that the pincite has been cited correctly as it can vary 

per the type of source. See Index p.500. (v.19) 

 

❖ Check INTRODUCTORY SIGNALS (“[no signal],” “See,” “See also,” etc.)  

 

❖ See Bluebook Rule 1.2, adding signals where necessary based on the above the line assertion. 

 

❖ Check Id.:  

 

o See Bluebook Rule 4.1; see also SDLP Use of Id., Supra, and Hereinafter p.20. 

▪ Confirm that every id.  is referring to the note right before it. 

▪ Confirm that every id. includes a reference to the author/title of the citation. 

▪ Confirm that id.  is not referencing a supra. 

 

❖ Check Supra:  

o See Bluebook Rule 4.2. 

▪ Confirm that every supra is referring to the correct note. 

▪ Confirm that every supra includes an additional reference to the author/title of the 

citation. 
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❖ Check INTERNET citations: 
 

o Website addresses should NOT be underlined or in blue/hyperlinked. Please make sure to 

remove the hyperlink instead of just changing the font color. 

o Check to see if the Internet source is a blog.  

▪ Use of blogs as sources is discouraged. 

o Limited use of a more authoritative source like the WALL ST J. L. BLOG, is 

acceptable. 

o Check that the link works. 

o If a direct citation to an internet source: 

▪ “available at” is NOT used 

▪ Date parenthetical format in order of preference: 1) date of Internet site, 2) last 

updated/last modified, or 3) last visited. 

▪ Use root URL if URL is too long. 

 

o If PDF or document format: 

▪ Include relevant pincite for citation. 

▪ Use “available at” 

 

o Parallel citations to internet source: 

▪ Include the explanatory phrase “available at.” 

 

o For every available at, make sure there is a comma before it. 

 

❖ For STATE JURISDICTIONAL DOCUMENTS, DO NOT RELY ON WESTLAW/LEXIS because 

they do not use the Bluebook Rules for legislative, administrative, or executive documents.  

o Use Table T.1 to find the correct format for state legislative, administrative, and executive 

materials. 

 

❖ Confirm that every citation has a space between the # and the first word AND a period at the end. 

 

❖ Cite SDLP in the following manner, See Bluebook Rule 16.5:  SUSTAINABLE DEV. L. & POL’Y 

o Example) David Hunter, Implications of the Copenhagen Accord for Global Climate 

Governance, SUSTAINABLE DEV. L. & POL’Y, Winter 2010, at 4, 4.
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CHECKLIST FOR USING Id., Supra, & Hereinafter 

 

  

❖ Verify that the numbers corresponding to supras are accurate when you 

complete your editing assignment. 

  

❖ Do not use supra alone. Always include an additional reference to the 

author/title of the citation. This also helps prevent confusion if text is cut 

and pasted. 

 

❖ [Note: EICs will change this before publication so the published version of 

SDLP conforms to the bluebook]. 

  

❖ NEVER have an id. reference a supra. 

 

o Good Example: 
24 BEARD, supra note 23, at 56. 
25 BEARD, supra note 23, at 25. 
26 BEARD, supra note 23, at 25. 

 

o Bad Example: 
24 BEARD, supra note 23, at 56. 
25 BEARD, id. 
26 BEARD, id. at 52. 

  

❖ Hereinafter is used only if it is not clear which source a supra refers to. 

 

o Example: 
23 HENRY BEARD, THE DICK CHENEY CODE 50 

(Simon & Schuster Paperbacks 2004). 
24 . . . . . 
25 BEARD, supra note 23, at 52. 
26 Henry Beard, Bush Picks a Loyalist to Replace a 

Politician, WASH. POST, Nov. 11, 2004, at A1 

[hereinafter Bush Picks a Loyalist]. See also BEARD, 

supra note 23, at 50. 
27 . . . . . 
28 BEARD, supra note 23, at 52; Bush Picks a Loyalist, 

supra note 26, at A2. 
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COMPUTER TIPS 
❖ Adobe 

o If you do not have Adobe Acrobat on your computer that allows you to highlight PDFs, the 

computers in the library have this program.  

o Log on with your student ID and password. 

 

❖ File Version – which Word file version is supported and not supported by SDLP 

o  

o Supported File Version (See Saving Word Compatible Documents) 

       *.doc  

 

o Unsupported File Version 

*.docx 

 

o Saving Word Compatible Documents 

 

o PCs:  

▪ Word 2016: 

1. Click File Tab (top left corner) 

2. Select Save As 

3. Save files in this format: Word 97-2003 Document (*.doc) 

4. Click OK 

 

o Macs:  

▪ Word 2016: 

1. Click File (top left hand corner) 

2. Go to Save As 

3. In the Save As window, go to File Format, and from the drop-down menu 

select Word 1997-2004 Document (.doc). 
4. Click OK 

❖ Small Caps. 

o PCs: Control + Shift + K 

▪ Word 2016: 
• Home tab => Font group box => click on the little button at the 

bottom-right of the Font group (Or Ctrl+D). Put a check in the box 

next to Small caps under Font. 
 

o Macs: Command + Shift + K 

▪ Word 2016: 

• Go to Format tab => Font (Or Command+D) => check the box next to 

Small Caps “Abc” 

❖ Cross-Referencing Footnotes 

o PCs:  

 Under the “References” tab in the “Captions” box, select “Cross-reference.”  

 Under “Reference type,” select footnote.  

 Under “Insert reference to,” select “footnote number.”  

 Select the relevant footnote from the list and click “Insert.” 
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o Macs:  

 On the Insert menu, click Cross-reference.  

 Under “Reference type” pop-up menu, select footnote.  

 Under “Insert Reference To” caption box, select “footnote number.”  

 Select the relevant footnote from the list and click “Insert.”  

 

TRACK CHANGES 

 

Always use track changes when making any changes to an article. 

 

PCs: Word 2016: 

◆ To turn on/off Track Changes go to Review tab => Track Changes. The button will be orange 

when Word is tracking changes. 

◆ If you want to make changes to your Track Changes settings go to the Track Changes button, and 

click on the bottom portion with the down arrow, then Change Tracking Options. This allows 

you to use or remove balloons, change the colors of your insertions and deletions. 

◆ Tip: to view the changes without the track changes highlights, adjacent to the Track Changes 

button is Display for Review, and select Final instead of Final: Show Markup. This will ensure 

that all changes are tracked, but will allow you to view the documents without all of the marks. 

 

Macs: Word 2016 

◆ To turn on/off Track Changes go to the Review tab (top of screen) and select Tracking and then 

click Track Changes On. 

◆ Tip: To continue to edit the document without seeing all of the Track Changes sidebars, go to 

Tracking and click No Markup. Changes will still be tracked, but you can edit the document as 

you would if Track Changes were turned off. 

◆ Tip: To display a toolbar with track changes, comment functions, and variable viewing options 

(final, markup, final showing markup, etc.), go to View > Toolbars and select “Reviewing”. 

 

COMMENTS 
 

PCs: Word 2010  

 To insert a comment in Word 2016, go to the Review tab, then check the New Comment button. 

Macs: Word 2016 

◆ To insert a comment in Word 2016 for Mac go to Insert on the top toolbar, then click comment. 
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